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Introduction
DataSweet 3.5.0 contains many new features that make DataSweet a really 
powerful tool for data handling in the classroom. This document only covers 
the new features and how they work. It is assumed you are already familiar with 
previous versions of DataSweet and with using Windows applications in general.

DataSweet 3.5.0 also has a whole host of improvements which are not covered in 
this document. 

DataSweet – What’s New: Version 3.5.0 written by Gary J.H. Atkinson 
Kudlian Software Limited, 8A Nunhold Business Centre, 

Dark Lane, Hatton, Warwickshire CV35 8XB 
Tel:  +44 (0) 1926 842544    Fax: +44 (0) 1926 843537 

e–mail: support@kudlian.net    web: www.kudlian.net
 Updates will be made available through our web site at www.kudlian.net



Page 2

DataPlot
Labelling
The nature of labelling the graphs has changed slightly to better fit with the 
multiple data series detailed below. Setting the Graph Title is still the same, but 
whereas before there were two writable fields which both set the labels for the 
data columns and also doubled up for labelling the axis of the graph, these fields 
are now only used to set the labels for the axes of the graph. The writable fields 
themselves are also appropriately labelled.

The first data column is now headed Categories and the second column Series 1. 
The second data column can have it’s heading changed when you edit the data 
series. This is used when displaying a legend for multiple data series.

If numeric values are entered into both columns and you choose to plot a line 
graph or a scattergram then DataPlot assumes that you wish to produce an X–Y 
plot, and the columns are then renamed X and Y appropriately.

Resizing the Data Columns
The bar between the data columns and the graph can now be dragged from left 
to right to change the width of the data columns’ table. This is particularly useful 
when using multiple data series.

Multiple Data Series
The biggest and most significant change is the support for multiple data series. 
The example file Eye Colours (Boy and Girls) illustrates how this feature can be 
used. This file is installed in the DataSweet Examples folder. In this example the 
number of each type of eye colour has been counted separately for boys and girls. 
In this way we can compare the different eye colours for boys and girls. Each data 
series has its own colour, so the automatic colour matching no longer applies, and 
there is a legend displayed on the right hand side of the graph labelling each of the 
data series.

There are now two ‘Data Series’ which have been labelled Boys and Girls. The 
labels for each data series are displayed in the heading for each column where the 
data is entered.

To edit the data series;

• Open the Data menu and choose the item Edit Data Series…
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You use the above dialogue box to add or remove a data series.

• Click on the up/down buttons to change the number of data series you require.

 You can have up to a maximum of four different series.

You can also change the name of the data series in each of the writable fields.

• Click in the writable field you wish to edit, and enter the name of the appropriate  
data series.

• Click OK to confirm your changes.

 The number of data columns will now change to the number of series and the 
headings also updated to reflect the names you gave them.

Displaying a Legend
Each of the graph types also allow you to display a legend which acts as a key for 
each of the data series. This is controlled by an additional checkbox in the Options 
dialogue for each of the graph types.

Printing a Graph from DataPlot
Each print dialogue box in DataSweet, (DataPlot, the Databases and DataCalc) 
now allow you to choose a printer from a drop-down list.
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Plotting X – Y Graphs
DataPlot can also plot graphs using X and Y numerical data. An example of this is 
demonstrated in the example file, Scattergram. You can see here that one quantity 
is being plotted against another.

Coefficient of Correlation = 0.91
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These options have been implemented to meet the requirement of data handling at 
Key Stages 3 & 4.

In the options dialogue box, there are checkboxes that enable you to show a Line 
of Best Fit as well as the Coefficient of Correlation.

Show Line of Best Fit
When this item is checked the points of the scattergram have a line drawn through 
them which best shows the ‘linear’ relationship between the two quantities 
being plotted. If the points are randomly scattered and there is no meaningful 
relationship between the two quantities then it is possible that a line will not be 
drawn. If you want an indication of exactly how closely the line fits the points then 
you can ask to see the ‘coefficient of correlation’.

Show Correlation
When this item is checked the Coefficient of Correlation is displayed. This is a 
number between -1 and 1 which signifies how closely the line fits the points in the 
scattergram.

The sign of the number indicates whether the gradient of the line is positive or 
negative.

If the absolute value of the number is below 0.5 then this implies there is no real 
correlation between the two quantities. As the number approaches 1 (or -1) then 
the correlation is stronger. A scattergram with only two points will always give a 
correlation of 1.
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Database
Opens Read Only Files
Although there is no apparent change to the application that supports this feature, 
a fair amount of work has been done to enable users to open database files 
which have ‘read only’ access. This means that children can open a database for 
searching and creating queries, but will not be able to alter the database in any 
other way.

If the file is read only or is in a folder where the users only have read access, 
then the database can only be interrogated but not updated. The title bar of the 
database will also have the text [Read Only] appended to the file name.

Multi-User Access
The databases can be used by more than one user at once, we call this multi-user 
access. A single database can be located on a shared drive, on a network server 
for example, and all users can simultaneously access and update the database.

If the file is not read only and is located in a folder, possibly on a network server, 
where the users have both read and write access then all users can change and 
update the database.

Finding a Record
The find feature allows a search to be carried out for a card by its name, or for text 
in the free text field. We have now added a button to the toolbar to access this 
feature

Searching – Creating Queries
A subset of the database can be viewed by creating a query. Once a query has 
been created it is added to a list of queries for the database. Each query can then 
be turned on and off from the Queries window. When you create a query you 
should give it a meaningful name which is then used in the queries window.

There are two new buttons on the toolbar relating to queries.

This button opens the Create Query dialogue box.

This button opens the Queries palette window.
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The Queries Window
The Queries palette window lists all queries that have been created since the 
database was opened. By default the queries are not saved after you close the 
database file. This is probably what you would most desire in a classroom where 
you want the children to learn how to create their own queries. However, it is 
possible for the queries to be saved in the database by using the keyboard shortcut 
CTRL+S. You must ensure that the Queries window is active when using this key 
press. You will get a message to confirm that the queries were successfully saved.

To open the queries window either;

• Choose Show Queries… from the Edit menu, or

• Click on the Queries Window button on the toolbar.  

You can select which queries should be applied to the database by clicking on the 
appropriate checkbox next to each query. As you do this, you will see that the total 
number of cards displayed will change.

Every time you create a new query it is added to the list and is automatically 
applied to the database.

If you want to create a new query for all the records in the database then you must 
first uncheck all the queries displayed in the list.

Add / Create a New Query
Clicking on this button opens the Create Query dialogue box as described on the 
previous two pages.

Delete a Query
Clicking on this button will delete the selected query from the list. If you delete all 
the queries and then use the keyboard shortcut CTRL+S then any saved queries 
will be removed from the database.

Rename a Query
Clicking on this button allows you to rename the selected query. This means 
that you can give it a more appropriate name if you had not done so when it was 
created. Renaming a query does not change the search criteria that was chosen 
when it was created.
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Exporting Data
The facility to create a report has been extended into a more general Exporting 
Data menu item in the File menu. This leads to a sub-menu where you can still 
choose to create a report as before but also export the database as a CSV file. The 
exported data will only contain the records that are currently being displayed in the 
cards, i.e. those that have any queries applied to them.

If you create a report then this can either be saved as a file in Rich Text Format 
(RTF) or Plain Text (TXT). These type of files can then be loaded into a word 
processor, edited and printed. If you chose Export CSV… then this will be saved as 
a Comma Separated Value file which can then be loaded into a spreadsheet such 
as DataCalc.

To save the data:

• Click on the Save button on the Report window’s toolbar.

 A Save as dialogue will open allowing you to save the report to a chosen 
location.
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DataFind
Editing the Fields
The most significant change to the database is in the DataFind template. This now 
allows you to add as many fields as you require for your database, to position them 
wherever you wish and to change their type.            

• Open the Edit menu and choose Edit Fields…

 The Edit Fields palette window will open:

When this palette window is open you cannot add, delete or view any of the 
records in the database. You must close this window in order to use the database.

Adding Fields to the Database
The top frame, labelled New Fields, contains controls that can be dragged from the 
palette into the main database window. When you do this a new field is added to 
the database.
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There are four types of control that you can drag into the main window. These will 
determine the type of field that will be created.

Resizing the Main Window
When adding fields to the database is it a good idea to resize the main database 
window first in order to make room for the new fields. The main database window 
can now be resized to whatever size is required.

Text, Number and Date Fields
The main control that you will use most often is labelled Text, Number or Date 
Field. When you drag this into the card then by default a new text field is created. 
If you wish to change it to a number, date or drop-down list then you must first 
select the field and then change its type as described below.

On / Off Field
An On / Off field has a checkbox which can be turned either on or off. This is 
sometimes referred to as a ‘boolean’ field. You would use this field for a state 
where the field has a value that is either true or false. For example, in a houses 
database you might have a checkbox for whether the house is sold.

URL Field and Resource Field
These are the same types of field as we implemented in 3.4.0. The difference now 
is that you can have as many of each type as you wish.

By dragging these buttons into the card you can create fields which either contain 
a URL link to a web page or a link to a file or application. This is particularly 
useful if you want to link to a very large file such as a movie or some music. These 
types of files would make the database very big if we were to ‘embed’ them in the 
database itself. It would also make using the database very slow.

Repositioning the Fields
Once you have added a new field to the database you can click and drag it around 
the main window to position it wherever you choose. When you add a new field 
into the database, take care not to drop it onto a field that is already on the card. If 
you do then you may find that one field then becomes hidden behind another.

Editing the Field Types
The text fields can be changed into the following types; Text, Whole Number, 
Decimal Number, Currency, Date and a Drop-down List.

To change the field type:

• Click on the field you wish to change in the main card window.

 A blue highlight ring will show which is the currently selected field. The Edit 
Fields palette window will now display the current settings for that particular 
field.

• Click in the writable field Field Label: to edit the text used to label the field.

• Click on the drop down list labelled Field Type: to change the type of field you 
wish to use.
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When you choose to change the field type you are given a warning that you might 
lose data when doing so. If you haven’t yet entered any data into the database then 
there is nothing to worry about. Also, changing from some types to others will not 
cause a loss of data. DataSweet will try to convert from one format to another. For 
example, changing between a text field and a drop down list will not lose any data. 
Changing from a Whole Number to a Decimal Number will not lose any data either, 
but changing from a Decimal Number to a Whole Number will lose the fractional 
parts of any numbers entered into the database.

Number Formats
When you choose a field type involving numbers then you can also define a format 
for the number, including units, number of decimal places etc. There are some 
pre-defined formats that you can also apply from the Field Format: drop down list.

Drop-down Lists
A field with a drop-down list has a list of values that can be chosen from a drop 
down list. This is useful if you know that a particular field can only have certain 
values. For example, in the Houses database, we have made the Tenure field a 
drop-down list containing only three values; Freehold, Leasehold and Rented. You 
can only add items to a drop-down list by using the Edit Fields palette window.

To create a drop-down list:

• Select the field you wish to make into a drop-down list.

• In the Edit Fields palette choose Drop-down List from the Field Type: list.

• Confirm that you wish to make this change.

• Select this field again in the main card window.

 We now need to add the values from which you wish to choose.

• Click in the writable field labelled New Value: and enter the text for the value 
you wish to add to the list.

• Click the button labelled Add to add the text to the list.

 The text you entered will now appear in the list of values.

• Continue adding as many values as you require for the list.

If you want to remove a value from the list then;

• Select the value you wish to remove from the list.

• Click on the Remove button.

Deleting a Field
To delete a field from the database:

• Click on the field you wish to delete in the main card window

• Press the DELETE key on the keyboard.

 A confirmation box will ask you to confirm this operation as you cannot undo 
this change.
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Finishing Editing Fields
When you have finished adding, removing and changing the fields then you must 
close the Edit Fields palette window to continue using the database. You can open 
the Edit Fields palette at any time to add new fields and change existing ones if 
you wish.

Entering Data into Text and Number Fields
• Click over the field into which you wish to enter your data.

• Enter your collected data.

Entering a Date into a Date Field
By default a new record that contains a date field will have that value ‘greyed out’ 
because there is no date set.
To enter a date:

• Click on the checkbox on the left of the field to make it active or click on the 
drop down arrow to the right of the field to open the date picker.

• You can either click on the date and change it’s value using the keyboard by 
entering numbers and using the arrow keys or alternatively you can use the 
arrows and click around the date picker to set the date you require.

Adding a URL Link
If there is no link associated with a URL field;

• Click on the URL button.

 A dialogue box will open where you can add the URL you wish to associate with 
the record.

If you want to change the URL link;

• Right click on the URL button to open the dialogue box.

 Once a URL has been set, the button will display a globe without the red circle. 
If you now left click on the button it should load your web browser and start to 
look for the URL you have entered.

Adding a Linked Resource
If there is no file associated with the linked resource button;

• Click on the resource button.

 A file browser dialogue will open where you can choose the file or application 
you wish to associate with the record.

If you want to change the linked resource;

• Right click on the linked resource button to open the dialogue box.

 Once a file has been associated, the button will display an icon for that 
particular type of file. If you now left click on the button it should load the 
application associated with that file type and also the file.
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Grouping Date Fields
A new powerful feature of DataSweet is the ability to group and count dates. If you 
have a date field and open the count window and set it to count on this field then 
by default it will list each date in the database along with the number of times it 
occurs. In an ourselves database each date would generally be unique unless two 
pupils shared the same birthday. DataSweet will allow you to group dates; by days, 
by months and by years. The group options dialogue box below illustrates the 
options available.

When grouping by Day or Month, there are no additional options available, each 
day and month is counted for each date in the database. When grouping by year 
the options are similar to grouping numerical fields.

Shortcut Tip
If you click on a field in the main window 
with the CTRL key held down then this will 
switch the count to that field.

Hold down the SHIFT key when clicking on a 
field to open the Count Options dialogue box.

Sorting Data
This is similar to sorting in previous versions except the sort criteria is 
‘remembered’ whilst the file is open. In previous versions the sorting was lost if you 
created a query or just refreshed the database.

In future versions we may allow you to create a sort as a type of query which can 
then be applied to the set of records through the Queries palette window.
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Table View
Another new feature is the ability to view the database as a table. This is only 
available using the DataFind template.

To see this;

• Open the Houses database.

• Choose Table from the View menu.

 The table view will open as shown:

The table view window can be resized as can the column widths for each of the 
displayed fields. The table view allows you to view more than one record at a time. 
Each record is displayed as a row with each of the fields represented by a column.

The table view allows us to apply filters to the set of records. You need to create at 
least one query to do this.

• Create a query as described in the DataSweet manual, giving it an appropriate 
name.

 The drop-down list of filters will now be enabled and you will be able to select 
your query.

• Choose the query you have just created from the drop-down list.

 You can also AND / OR any two filters in the table view. You will need to have 
created at least two queries to do this.
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DataCalc
Drag to Copy
The current cell now displays a small black square at the bottom right hand corner. 
When you move the pointer over this square, the shape of the pointer changes to 
indicate that you can drag this cell either across a row or down a column to copy 
the data in the cell. If the cell contains formulae then these are copied using the 
usual rules for changing any cell references.

Copying Graphs to the Clipboard
Graphs now have a pop-up menu which is opened by right clicking on the graph, 
this contains a menu item that allows you to copy the graph to the clipboard.

Import and Export CSV Files
DataCalc can now export CSV and TAB separated data from the File menu.

To import a CSV file, choose Import Data… from the Data menu.

Printing Formulae
There is now an option in the print dialogue box to allow the printing of formulae. 
These are printed on separate pages.
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